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Abstract 

This document describes a software deliverable responsible for the Extraction, Transformation and Loading 

(ETL) of the data related to the ACTIVE case studies and to the Active Knowledge Work Space (AKWS) 

system. The actual deliverable code with a readme file is located in the ACTIVE project subversion 

repository. The purpose of this deliverable is to describe the first version of the software which aims at 

extracting the data from the systems of the ACTIVE case study partners and the developed AKWS system. 

The described ETL module is delivered as running code. This deliverable will be subject to comprehensive 

validation process where feedback from the end users and the project partners will be collected to aid in 

planning the next release of the ETL module. The deliverable also describes how semantically enabled social 

browsing solution called LiveNetLife will be used in ACTIVE. 

 

[End of abstract] 
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Executive summary  

As planned in the project, Context Mining is addressed here in connection with the AKWS prototype and the 

requirements of the ACTIVE case studies. Therefore, we created a first prototype for Extracting, 

Transforming and Loading (ETL) of the data into the analytical functionalities and services developed in the 

scope of WP2. The prototype extracts data out of the AKWS system and other instrumented systems of the 

case study partners, transforms it into Time, Network, Time (TNT) structure and stores it into the TNT Store 

described in D2.1.1 Construction of the probabilistic temporal process model for knowledge processes [1] 

and implemented in D2.1.2 Simulator of knowledge processes through probabilistic temporal processes [2]. 

The data which is subject to this ETL processing with the developed module is the following: 

 1. AKWS stream of events directly routed into the ETL tool 

 2. AKWS log of events stored in a form of an xml file 

 3. Cadence log of a design process 

 4. Accenture documents 

What is more, we describe how existing web service for semantically enabled social browsing called 

LiveNetLife can be used in the scope of ACTIVE for the purpose of connecting knowledge workers who are 

working in similar context or on similar tasks. 
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Definitions 
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1 Introduction  

Context Mining is developed on the data resulting from the AKWS prototype and the data directly provided 

by the ACTIVE case studies partners following the requirements of the ACTIVE case studies. As the first 

preconditioning step for data analysis, we created a software prototype for Extracting, Transforming and 

Loading (ETL process) the data into the ACTIVE analytical services. What is more, we describe how the 

existing web service for semantically enabled social browsing called LiveNetLife can be used in the scope of 

ACTIVE for the purpose of connecting knowledge workers who are working in similar context or on similar 

tasks. 

 

The described ETL prototype extracts data out of the AKWS system and other instrumented systems of the 

case study partners, transforms it into Time, Network, Time (TNT) [1] structure ready for data mining and 

stores it into the TNT Store implemented and described in [2]. The data which is subject to this ETL 

processing with the developed module is the following: 

 1. AKWS stream of events directly routed into the ETL tool 

 2. BT log of events as captured in AKWS stored in a form of an xml file 

 3. Cadence log of a design process 

 4. Accenture documents 

The developed software deliverable is located in the ACTIVE project subversion repository 

 http://svn.active-project.eu/active/repos 

 in  

/wp2/d221/bin 

directory. The software deliverable is provided in form of a zip package and the related ñreadmeò file: 

 ActiveETLTool.zip 

 ActiveETLTool_readme.doc 

The ActiveETLTool_readme.doc contains detailed instructions for installing, running and validating the 

software functionality.  

 

The LiveNetLife web service will enable knowledge workers to become aware of each other when working 

in similar context or on similar tasks. We describe the service and its unique capabilities together with 

highlighting the possibilities of its use for the ACTIVE purposes. 

 

The rest of this document is organized as follows. Section 2 describes how the AKWS data stream coming 

out of ACTIVE instrumented tools is extracted, transformed and loaded into the TNT Store. What is more, 

this section also explains ETL process in the scope of BT case study and how the xml log created out of the 

AKWS data stream can be loaded into the TNT. Section 3 explains the ETL process in the scope of Cadence 

case study. Section 4 explains the transformation of data in the scope of Accenture case study. Section 5 

gives an overview of the possibilities for LiveNetLife functionality used in ACTIVE. We conclude with a 

summary of the deliverable in Section 6. 

  

http://svn.active-project.eu/active/repos


ACTIVE Deliverable D2.2.1 

Page 10 of (28)  © ACTIVE consortium 2008 

 

2 Extraction, Transformation and Loading of the AKWS data 

stream 

In this section we describe the ActiveETLTool, which subsumes the stream of data coming out of the AKWS 

system and stores it inside the TNT store. We first describe the data stream created by the AWKS system and 

then how we transform this stream for the purposes of storing it in the TNT mining store. Finally, we 

describe how the log of such events produced by the ACTIVEMessageConsumer.exe tool is also processed 

in the same way. 

 

2.1 AKWS data stream 

 

The AWKS system developed inside ACTIVE aims at providing help to the knowledge worker with 

managing his computer system working environment in order to become more effective when working with 

a computer system [5]. In order to achieve this goal the AKWS system is instrumented so that all the user 

interactions with the system are recorded with the purpose of analysis and search for hidden patterns which 

give more insight into how the knowledge worker could become more efficient by exploiting theses patterns.  

 

The AKWS system currently supports the instrumentation of the following applications [5]: 

 Internet Explorer 

 MS Outlook 

 MS Word 

 

The data stream coming out of these instrumented applications describes users' interactions with these 

applications in a form of XML fragments.  The specific events captured inside AKWS system and their xml 

representation are described in detail in [5]. The currently supported events captured by the AKWS system 

include: 

 Word File Read  

 Word File Update  

 Email View 

 Email Send 

 Email Reply 

 Web Browser Navigate  

 

For instance, the event of a user browsing to a web page (WebNavigate event) is recorded and streamed out 

of the AKWS system in the xml fragment displayed as Code Snippet 1 in Figure 1. 

 

<NavigateEvent> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 12:23:43</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>591e4790-07e7-11de-87a1-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>WebBrowserEvent</EventType> 

        <Operation>NavigateEvent</Operation> 

        <OutputParameter> 

          <ID>http://semantic.info.bt.co.uk/wiki/index.php/Main_Page</ID> 

          <URL>http://semantic.info.bt.co.uk/wiki/index.php/Main_Page</URL> 

        </OutputParameter> 

 </NavigateEvent> 

 

Figure 1Code Snippet 1- XML fragment encoding the Web Navigate Event as it is received from the AKWS 

system. 
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The AKWS system observes the user interactions inside the client computer system and forwards them to the 

Event Bus service [5]. The Event Bus service enables to consume these events by any software component 

which registers with the event bus. This is the mechanism we used to enable the ActiveETLProcess tool to 

consume the AKWS events. 

 

2.2 ETL of AKWS Data Stream 

 

The process of extracting, transforming and loading of the AKWS data stream into the form suitable for 

storing with the TNT store and then later for analysis is explained in this section. The process is explained 

for every type of event separately. 

 

2.2.1 Word File Read Event 

The example of a Word Read File event, coming out of the AKWS system is encoded in the following two 

XML code snippets. In the Code Snippet 2 the fragment describes the event of somebody reading a file. 

Among other information, it gives detailed information on who is the document reader, the time of the event 

occurrence and the local address of the document. Code Snippet 3 in Figure 3, on the other hand describes 

the actual content of the file, which was read by the user as described as Code Snippet 2 in Figure 2. 

 

<WordReadFile> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 12:52:46</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>8ece8070-0982-11de-8786-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>WordEvent</EventType> 

        <Operation>WordReadFile</Operation> 

        <InputParameter> 

          <ID>  fdd26de6-924f-49a5-b517-9e06259be728 </ID>  

          <DocumentName>C:\documents and settings\802516228\Desktop\bid2\job 

massey.docx</DocumentName> 

        </InputParameter> 

 </WordReadFile>  

 

Figure 2 Code Snippet 2 - XML fragment encoding the Read File Event as it is received from the AKWS 

system.  

 

<Message> 

    <ReceivedAt>05/03/2009 12:52:41</ReceivedAt> 

    <Type>File</Type> 

    <GroupID>9328f006-203d-46cc-be51-43ba925160f9</GroupID> 

    <File>WordFile_fdd26de6-924f-49a5-b517-9e06259be728_job massey.doc</File> 

  </Message> 

  <Message> 

 

Figure 3 Code Snippet 3 - XML fragment encoding the content of the word file read as described by Read 

File Event in Code Snippet 1. 
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Information Extraction  

 

Out of the data in the form of XML fragments we extract information on Time, Network and Text (TNT) by 

reading when did the event occur (Time), who is the person reading the document (Network) and what is the 

textual content written in the document (Text). 

 

Information Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is 

 Network information about the user reading the file (user name) can be transformed into the user's 

email (user email) 

 Textual Information is preserved and assigned a tag that this text is the input to the knowledge 

worker. 

 

Information Loading  

 

The transformed information is loaded into the TNT store. Every person is stored as a separate network 

entity. Textual information of the read document is added to the network entity description together with the 

time stamp and the input tag.  

 

2.2.2 Word File Update Event 

The example of a Word Update File event, coming out of the AKWS system is encoded in the following two 

XML code snippets. In Code Snippet 4 in Figure 4, the fragment describes the event of somebody updating a 

word file. Among other information, it gives detailed information on who is the document editor, the time of 

the event occurrence and the local address of the document itself. Code Snippet 5 in Figure 5 describes the 

actual content of the file before modification, which was updated by the user as described in Code Snippet 4 

in Figure 4. Code Snippet 6 in Figure 6describes the actual content of the file after the modification, which 

was updated by the user as described in Code Snippet 4. 

 

<WordUpdateFile> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 12:52:39</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>8ece8070-0982-11de-8786-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>WordEvent</EventType> 

        <Operation>WordUpdateFile</Operation> 

        <InputParameter> 

          <ID>b608b3e5-11c6-4c88-9b0b-4ada6ab9c1de</ID> 

          <DocumentName>C:\documents and settings\802516228\Desktop\bid2\job 

massey.doc</DocumentName> 

        </InputParameter> 

        <OutputParameter> 

          <ID>  

          </ID>  

          <DocumentName>C:\documents and settings\802516228\Desktop\bid2\job 

massey.doc</DocumentName> 

        </OutputParameter> 

   </WordUpdateFile>  

 

Figure 4 Code Snippet 4 - XML fragment encoding the Update File Event as it is received from the AKWS 

system.  
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<Message> 

    <ReceivedAt>05/03/2009 12:52:41</ReceivedAt> 

    <Type>File</Type> 

    <GroupID>9328f006-203d-46cc-be51-43ba925160f9</GroupID> 

    <File>WordFile_fdd26de6-924f-49a5-b517-9e06259be728_job massey.doc</File> 

  </Message> 

 

Figure 5 Code Snippet 5 - XML fragment encoding the content of the word file read as described by Update 

File Event in Code Snippet 4. 

 

<Message> 

    <ReceivedAt>05/03/2009 12:52:41</ReceivedAt> 

    <Type>File</Type> 

    <GroupID>9328f006-203d-46cc-be51-43ba925160f9</GroupID> 

    <File> WordFile_1d87dd44-7759-4bbb-bcb0-e9959ce4ae66_job massey.doc</File> 

  </Message> 

 

Figure 6 Code Snippet 6 - XML fragment encoding the content of the word file read as described by Update 

File Event in Code Snippet 4. 

 

 

Information Extraction 

 

Out of the data in the form of XML fragments we extract information on Time, Network and Text (TNT) by 

reading when did the event occur (Time), who is the person updating the document (Network) and what is 

the textual content of the document (Text) before and after the update. 

 

Information Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is 

 Network information about the user updating the file (user name) can be transformed into the user's 

email (user email) 

 Textual Information of the document before the update is preserved and assigned a tag that this text 

is the input to the knowledge worker. Textual Information of the document after the update is 

preserved and assigned a tag that this text is the output of the knowledge worker. 

 

Information Loading  

 

The transformed information is loaded into the TNT store. Input textual information of the updated 

document is added to the network entity of the person updating the document together with the time stamp 

and the input tag. Output textual information of the updated document is added to the network entity of the 

person updating the document together with the time stamp and the output tag.  

 

 

2.2.3 Email View Event 

The example of an Email View event, coming out of the AKWS system is encoded in the following two 

XML code snippets. In Code Snippet 7 in Figure 7, the fragment describes the event of somebody reading an 

email message. Among other information, it gives detailed information on who are the sender and recipient 

of the message, the time of the event occurrence and subject, body and attachments of the message. Code 

Snippet 8 describes the actual content of the message attachment. 

 

<ViewMailEvent> 
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        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 12:49:59</DateTime> 

        <Task>Working on deliverable</Task> 

        <TaskContext>8ece8070-0982-11de-8786-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>EmailEvent</EventType> 

        <Operation>ViewMailEvent</Operation> 

        <InputParameter> 

          <ID>3f6bc10e-551d-4884-9e75-76c634f5d1eb</ID> 

          <From>nick.kings@bt.com</From> 

          <To>Kings,NJ,Nick,CXR3 R,nick.kings@bt.com;</To> 

          <Subject> 

          </Subject> 

          <Cc> 

          </Cc> 

          <Attachments> 

            <Attachment>Context_scenario_b_pw.docx</Attachment> 

          </Attachments> 

          <Body> 

          </Body> 

        </InputParameter> 

      </ViewMailEvent>  

 

Figure 7 Code Snippet 7 - XML fragment encoding the View Email Event as it is received from the AKWS 

system.  

 

<Message> 

    <ReceivedAt>05/03/2009 12:52:41</ReceivedAt> 

    <Type>File</Type> 

    <GroupID>9328f006-203d-46cc-be51-43ba925160f9</GroupID> 

    <File>WordFile_fdd26de6-924f-49a5-b517-9e06259be728_job massey.doc</File> 

  </Message> 

  <Message> 

 

Figure 8 Code Snippet 8 - XML fragment encoding the content of the file attached to the message encoded 

in Code Snippet 7. 

 

Inf ormation Extraction  

 

Out of the data in the form of XML fragments we extract information on Time, Network and Text (TNT) by 

reading when did the Email View Event occur (Time), who is the person viewing the message (Network), 

who are the senders and receivers of the message (Network) and what is the textual content of the message 

subject and body(Text). If message attachments contain textual content then we extract text out of these as 

well (Text)  

 

Information Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is 

 Network information about the user reading the message (user name) is transformed into the user's 

email (user email) 

 Textual Information is preserved and assigned a tag that this text is the (1) input to the knowledge 

worker, (2) input to the message recipient and (3) output of the message sender 

 

Information Loading  
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The transformed information is loaded into the TNT store. Input textual information of the read email is 

added to the network entity of the person reading the document together with the time stamp and the input 

tag. Input textual information of the read email is added to the network entity of other recipients reading the 

document together with the time stamp and the input tag. Output textual information of the read email is 

added to the network entity of senders reading the document together with the time stamp and the output tag. 

 

2.2.4 Email Send Event 

The example of an Email Send event, coming out of the AKWS system is encoded in the following two 

XML code snippets. In the Code Snippet 9 in Figure 9 the fragment describes the event of somebody sending 

an email message. Among other information it gives detailed information on who are the sender and 

recipient of the message, the time of the event occurrence and subject, body and attachments of the message. 

The content of the message attachments are transported in an xml fragment equivalent to the already 

described Code Snippet 8 in Figure 8. 

 

<SendMailEvent> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 16:24:28</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>418dbce0-0982-11de-8786-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>EmailEvent</EventType> 

        <Operation>SendMailEvent</Operation> 

        <OutputParameter> 

          <ID>19e62815-bf60-4d85-a5bd-2366c4b19d16</ID> 

          <From>nick.kings@bt.com</From> 

          <To>Jure Ferlez,Jure.Ferlez@ijs.si;</To> 

          <Subject>RE: Event capture log?</Subject> 

          <Cc> 

          </Cc> 

          <Attachments> 

          </Attachments> 

          <Body>Jure, our external server...... 

 

.... 

This email contains BT information, which may be privileged or confidential. 

It is meant only for the individuals or entities named above. If you're not the intended recipient, note that 

disclosing, copying, distributing or using this information is prohibited. If you've received this email in error, 

please let me know immediately on the email address above. Thank you. We monitor our email system, and 

may record your emails. 

 

 

British Telecommunications plc 

Registered office: 81 Newgate Street London EC1A 7AJ 

Registered in England no: 1800000 

 

Â  

</Body> 

        </OutputParameter> 

      </SendMailEvent>  

 

Figure 9 Code Snippet - XML fragment encoding the Send Email Event as it is received from the AKWS 

system.  
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Information Extraction  

 

Out of the data in the form of XML fragment we extract information on Time, Network and Text (TNT) by 

reading when did the Email Send Event occur (Time), who is the person sending the message (Network), 

who are the senders and receivers of the message (Network) and what is the textual content of the message 

subject and body(Text). If message attachments contain textual content then we extract text out of these as 

well (Text).  

 

Information Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is 

 Network information about the sender of the message (user name) is transformed into the user's 

email (user email) 

 Textual Information is preserved and assigned a tag that this text is the (1) output to the knowledge 

worker, (2) input to the message recipient and (3) output to the message sender (if different from the 

knowledge worker) 

 

Information Loading  

 

The transformed information is loaded into the TNT store. Input textual information of the sent email is 

added to the network entity of the person sending the message together with the time stamp and the output 

tag. Input textual information of the read email is added to the network entity of recipients of the message 

together with the time stamp and the input tag.  

2.2.5 Email Reply Event 

The example of an Email Reply event, coming out of the AKWS system is encoded in the following two 

XML code snippets. In Code Snippet 10 in Figure 10, the fragment describes the event of somebody replying 

to an email message. Among other information, it gives details on who are the sender and recipient of the 

new message, who are the sender and recipients of the original message being replied to, the time of the 

event occurrence, subject, body and attachments of both the original message and the reply message. Again, 

xml similar to Code Snippet 8 describes the actual content of the message attachment. 

 

<ReplyMailEvent> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>06/03/2009 13:06:56</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>591e4790-07e7-11de-87a1-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>EmailEvent</EventType> 

        <Operation>ReplyMailEvent</Operation> 

        <InputParameter> 

          <ID>79c61c94-7d88-4eea-9976-cbd01070f03c</ID> 

          <From>nick.kings@bt.com</From> 

          <To>Kings,NJ,Nick,CXR3 R,nick.kings@bt.com;Davies,NJ,John,CXR3 R,john.nj.davies@bt.com, 

....</To> 

          <Subject>RE: Terms of service for a skip hire</Subject> 

          <Cc>Hawkins,JA,Jon,CRF R,jon.hawkins@bt.com;</Cc> 

          <Attachments> 

          </Attachments> 

          <Body>means that they prefer cash as the VATman doesn't know about it. 

.... 

British Telecommunications plc 

Registered office: 81 Newgate Street London EC1A 7AJ 

Registered in England no: 1800000 
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</Body> 

        </InputParameter> 

        <OutputParameter> 

          <ID>16b6a48a-745c-4bcf-b711-e85a07f2be8e</ID> 

          <From>nick.kings@bt.com</From> 

          <To>Oliver,A,Adam,CXR8 R,adam.2.oliver@bt.com;Davies,NJ,John,CXR3 

R,john.nj.davies@bt.com;Weeks,R,Richard,CXR3 R,....  </To> 

          <Subject>RE: Terms of service for a skip hire</Subject> 

          <Cc>Hawkins,JA,Jon,CRF R,jon.hawkins@bt.com;</Cc> 

          <Attachments> 

          </Attachments> 

          <Body>Ah, no-one won the prize. 

 

.....  

 

British Telecommunications plc 

Registered office: 81 Newgate Street London EC1A 7AJ 

Registered in England no: 1800000 

 

Â  

</Body> 

        </OutputParameter> 

      </ReplyMailEvent> 

    </Event> 

  </Message> 

  <Message>  

 

Figure 10 Code Snippet 10 - XML fragment encoding the Reply Email Event as it was received from the 

AKWS system.  

 

 

Information Extraction  

 

Out of the data in the form of XML fragment, we extract information on Time, Network and Text (TNT) by 

reading when did the Email Reply Event occur (Time), who is the person sending the reply message 

(Network), who are the senders and receivers of the original and reply message (Network) and what is the 

textual content of the reply and original message subject and body(Text). If any message attachments contain 

textual content then we extract text out of these as well (Text)  

 

Information  Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is 

 Network information about sender of the  reply message (user name) is transformed into the user's 

email (user email) 

 Textual Information of the reply message is preserved and assigned a tag that this text is the (1) 

output to the knowledge worker, (2) input to the message recipient and (3) output to the message 

sender (if different from the knowledge worker) 

 Textual Information of the original message is preserved and assigned a tag that this text is the (1) 

input to the knowledge worker, (2) input to the message recipients (if any are different from the 

knowledge worker) and (3) output of the message sender (if different from the knowledge worker) 

 

 

Information Loading  
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The transformed information is loaded into the TNT store. Output textual information of the replied email is 

added to the network entity of the person sending the message together with the time stamp and the output 

tag. Input textual information of the replied email is added to the network entity of recipients of the message 

together with the time stamp and the input tag. 

 

2.2.6 Web Browser Navigate 

The example of a Web Browser Navigate event, coming out of the AKWS system is encoded in the 

following XML code snippet. In the Code Snippet 11 in Figure 11 the fragment describes the event of 

somebody opening a web page at some web address. Among other information it gives detailed information 

on who is the person using the word wide web, the time of the event occurrence and the internet address of 

the opened web page.  

 

<NavigateEvent> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 12:23:43</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>591e4790-07e7-11de-87a1-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>WebBrowserEvent</EventType> 

        <Operation>NavigateEvent</Operation> 

        <OutputParameter> 

          <ID>http://semantic.info.bt.co.uk/wiki/index.php/Main_Page</ID> 

          <URL>http://semantic.info.bt.co.uk/wiki/index.php/Main_Page</URL> 

        </OutputParameter> 

 </NavigateEvent> 

 

Figure 11 Code Snippet 11 - XML fragment encoding the content of the Web Browser Navigate event as 

described as it was received from the AKWS system. 

 

Information Extraction 

 

Out of the data in the form of XML fragments we extract information on Time, Network and Text (TNT) by 

reading when did the event occur (Time), who is the person browsing the internet (Network) and what is the 

textual content written in the page accessed by the user (Text). We do that by reading the HTML content of 

the page at the specified URL. 

 

Information Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is 

 Network information about the user reading the file (user name) can be transformed into the user's 

email (user email) 

 Textual Information is preserved and assigned a tag that this text is the input to the knowledge 

worker. 

 

Information Loading  

 

The transformed information is loaded into the TNT store. Input textual information of the read web page is 

added to the network entity of the person browsing the internet together with the time stamp and the input 

tag.  
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2.3 Extraction, Transformation and Loading of the BT use case data 

provided as AKWS Logs 

The AKWS system can be setup to store all the events induced inside the system into a XML log file. The 

implemented ActiveETLProcess.exe tool can be used to process such offline log as if it was a live data 

stream. Code Snippet 12 in Figure 12 shows portions of the XML log which was recorded at the BT 

premises.  

<Messages> 

  <Message> 

    <ReceivedAt>05/03/2009 12:18:05</ReceivedAt> 

    <Type>Text</Type> 

    <GroupID>4d681936-615e-4304-988d-0dbba0390412</GroupID> 

    <Event> 

      <NavigateEvent> 

        <EventDomain>PrimitiveEvents</EventDomain> 

        <DateTime>05/03/2009 12:18:05</DateTime> 

        <Task>None for now</Task> 

        <TaskContext>591e4790-07e7-11de-87a1-0012f0a6065e</TaskContext> 

        <User>nick</User> 

        <EventType>WebBrowserEvent</EventType> 

        <Operation>NavigateEvent</Operation> 

        <OutputParameter> 

          <ID>http://gf -gateway.nat.bt.com/blank.html</ID> 

          <URL>http://gf-gateway.nat.bt.com/blank.html</URL> 

        </OutputParameter> 

      </NavigateEvent> 

    </Event> 

  </Message> 

  <Message> 

    <ReceivedAt>05/03/2009 12:18:10</ReceivedAt> 

    <Type>Text</Type> 

    <GroupID>88429b61-4fc5-46b2-a0f1-1d47dcb46146</GroupID> 

    <Event> 

      <NavigateEvent> 

        <EventDomain>..... 

 

Figure 12 Code Snippet 12 - XML log of the AKWS events produced by the 

ACTIVEMessageConsumer.exe service. 

The ActiveETLProcess.exe tool was implemented to consume such a log file as if it was connected to a live 

stream of data. All the ETL techniques described in previous sections apply for the processing of this log as 

well.  
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3 Extraction, Transformation and Loading of the CADENCE 

use case data  

The Cadence use case data comes in a form of a log of Cadence engineer activities. Engineers are using 

different tools to produce chip designs. Every time an engineer runs a tool a record or a "tick" is created. The 

idea in ACTIVE is to analyze these records to find the patterns which would enable Cadence management to 

better understand the design process [3]. 

The cadence log may come in the form of an XML file, which is partly presented in Code Snippet 13 in 

Figure 13. Each record contains information on the [4]:  

 Id, id_start, id_end;  There are two types of valid Id fields in the log. The first one refers to the start 

of a tool and is called id_start and, the second refers to the completion of the job performed by the 

tool and is called id_end.  

 Engineer; Ticks also contain annonymized login information which corresponds to the designer 

who used the tool. This information is contained in the login field;  

 Context and other information ; Several fields describe context and other potentially useful 

information related to the engineerôs work. The design field refers to the part of the design being 

worked on; the wbname field refers to the part of the Cadence workbench being used; the milestone 

field refers to the milestone of the design process being worked on; the task field refers to the task 

being worked on; the forks field specifies if the number of parallel runs of the current task if these 

exist; the modules field specifies the modules or subcommands used; the hostname field specifies the 

name of the machine running the job; the runname field specifies the name of the run and is an 

aggregate of other fields; the workdir field specifies the directory in which the job ran;the interactive 

field specifies if the job required user input; the  status field specifies if the tool completed the job 

successfully or it was faulty in some way.  

 Time. The log file also contains two fields specifying the time when the tool was started (start_time) 

and the time it took to run (duration).  

<table> 

  <row> 

    <cell>id</cell>    <cell>id_start</cell>    <cell>id_end</cell>    <cell>login</cell>  

    <cell>design</cell>    <cell>wbname</cell>    <cell>milestone</cell>    <cell>task</cell> 

    <cell>forks</cell>    <cell>modules</cell>    <cell>hostname</cell>    <cell>runname</cell> 

    <cell>start_time</cell>    <cell>duration</cell>    <cell>reason</cell>    <cell>workdir</cell> 

    <cell>interactive</cell>    <cell>status</cell>    <cell>start_string</cell>    <cell>wbfile</cell> 

    <cell>planfile</cell>    <cell>logfile</cell>  

  </row> 

  <row> 

    <cell />    <cell>256</cell>    <cell>257</cell>    <cell>&designer_1;</cell> 

    <cell>65nm</cell>    <cell>ccd</cell>    <cell>Msi</cell>    <cell>do_ccd</cell> 

    <cell />    <cell>{0 custom}</cell>    <cell>muvccs12</cell>    <cell>ccd/do_ccd</cell> 

    <cell>1211878471</cell>    <cell>175</cell>    <cell>atp</cell> 

    <cell>/projects/MNSICD/65nm/run/ccd</cell>    <cell>1</cell>    <cell>ok</cell> 

    <cell>Tue May 27 10:54:31 2008</cell>    <cell />    <cell />    <cell /> 

  </row> ...  

 

Figure 13 Code Snippet 13 - Cadence designer log data encoded in an XML file. 

Information Extraction  

 

Out of the data in the form of an XML log, we extract information on the person doing the design, the time 

of the event and the information about the particular action which triggered the event. We do that by reading 

when did design event occur (start_time, duration), who is the person being recorded (login). The 

information in the form of different fields describing the design action are extracted: design, wbname, 



Deliverable D2.2.1 ACTIVE 

© ACTIVE consortium 2008 Page 21 of (28)  

 

milestone, task, forks, modules, hostname, runname, reason, workdir, interactive, status, start_string, wbfile, 

logfile. 

 

Information Transformation  

 

The extracted information is transformed in the following way: 

 Temporal Information is preserved as it is (Time) 

 Information about the engineer performing the action is preserved as it is (Network) 

 Information about the design action are aggregated into a single textual record for the purposes of 

analysis of the influence of the design parameters on the extracted process in the later stages of the 

project (Text). 

 

Information Loading  

 

The transformed information is loaded into the TNT store. Textual information of the tick is added to the 

network entity of the person working on a chip design together with the corresponding time stamp.  
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4 Extraction, Transformation and Loading of the 

ACCENTURE SABLE log 

The ACCENTURE use case data comes in a form of a database log of usage of the SABLE Application [6], 

which provides advanced search functionality on corporate documents. The idea in ACTIVE is to analyze 

this logs for the purposes of capturing the browsing habits of the ACCENTURE knowledge workers. The 

following subsection describes the log data in detail. Next subsection describes the ETL process for the 

ACTIVE purposes 

4.1. ACCENTURE SABLE Log 

 

The ACCENTURE SABLE log provides detailed information on the queries issued by the user, the 

navigation behaviour on the search results, the detailed profiles of the users and the detailed information on 

the queries documents including full text of these documents. Technically the log is stored in a relational 

database and in a form of textual dump files on a disk drive.  

The main tables of the SABLE log in a relational database are the following.  

4.1.1 kx_metadata 

The kx_metadata table contains 100K records of document meta data. Every row contains 55 columns 

including:  

 file properties: time created, time modified, created, ContentCurrentDate, detailsPageUrl, 

DateCreated, DateModified, FileSize, ContentCurrentDate 

 textual properties: Title, Abstract, Topic tags, ?Name(same as fname)?, 

ConditionsforUseComments, Keywords tags,  

 foreign keys or anonymization: ConditionsforUse, IndustryKeywords, BusinessFunctionKeywords, 

TechnologyKeywords, VendorProductKeywords, Alliances, Offerings, ApprovedForUseBy, 

PertinentToOrgUnit, PertinentToServiceLine, PertinentToDomainSpecialty, PertinentToWorkgroup,  

PertinentToCountry, ItemTypeCode, KeywordsCode,  

 named entities: Client 

 status fields: ArchiveStatus, MarketMaker, Language   

 mostly empty fields: CredentialChampion, CredentialDevelopmentStatus, CredentialOrganization, 

CredentialPerson, ProposalStatus, SubmitingOrganisation, Description, CredentialType, 

EngagementPartner, ClientPseudonyms. 

 

4.1.2 myCV_profiles 

The myCV_profiles table contains 53 columns and 170K records of personal profile entries. There are 170 

000 different Accenture emails mentioned, where every email represents one real person. In detail the 

following columns or fields are available: 

 Profile Application Status fields: Profile_Account_Role,Profile_Entity_A, Profile_Entity_B, 

Profile_Entity_C 

 Primary key: Profile_Personnel_# 

 Foreign keys or anonymization: Profile_Bill_Code, Profile_Cost_Center_Number, Profile_HR-

Rep_Personnel_#, Profile_Octel_Number 

 Temporal Data: Profile_Calendar_LastUpdate, Profile_First_Availability_Date, 

Profile_First_Available_Day_After_Booking, Profile_Current_RollOff_Date, 

Profile_Last_Modified_Date, Profile_Last_Promotion_Date,  

 Named Entities: Profile_Career_Counselor, Profile_Name, Profile_Email, Profile_Geo_Unit, 

Profile_HR-Rep, Profile_Metro_City, Profile_Wrkfrc/Wrkgrp,  

 Employee Information: Profile_Class (position), but what is then ??Profile_Level??, 

Profile_Country, Profile_Current_Calendar_Entry, Profile_Current_Client, Profile_Current_Project, 

Profile_Deployment_Detail, Profile_Is_Under_12_Months_At_Level, Profile_Office_Location,  

Profile_Skills, Profile_Specialty,  
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 Mostly Empty: Profile_Comment, Profile_Visa_Information,  

 Not understandable fields: PctCurProd, PctYrToDtProd, Profile_additional_deployment_detail, 

Profile_Alignment, Profile_Capability, Profile_HR-Rep_Email, 

 

4.1.3 sable_log 

The sable_log table contains 6 columns and 700K records about SABLE search application usage log. Every 

record describes an interaction of the person with the SABLE search engine. Every interaction belongs to 

one of the 5 action types: 

 PAGE_CLICK  - url of object which was clicked 

 THUMB_CLICK - url of object which was clicked 

 DOWNLOAD_CLICK - url of file which was downloaded 

 SEARCH - object is the query: walmart, BPM DDR Use Case, Risk Management Plan, ... 

 LOGIN - no object 

In detail the following fields are available in the database: 

 Primary key,  

 Person Id  

 Computer Ip  

 Action Timestamp 

 Action 

 Object 

 

4.2 ETL of SABLE Log Data 

 

Information Extraction  

 

In Accenture case study we first focused on analysis of the textual content of the documents (Text). We used 

the information in the kx_metadata table to extract creation time information of every document. Since the 

networking information was missing we used the text mining techniques to identify the named entities which 

are mentioned in the text. This way we extracted names of people who are mentioned in the document. 

 

Information Transformation  

 

The extracted information on textual content of the documents  was preserved to constitute the Text part of 

the TNT record. People mentioned in the documents, extracted with text mining techniques are used to form 

a network of people who are related somehow (as they were mentioned in the same document). This 

constitutes the Network part of the TNT record. The temporal part of the TNT record is the creation date of 

the examined document. 

 

Information Loading  

 

The extracted Text, Network and Time information loaded into the TNT store in a straight forward way. 
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5 Semantically Enabled Social  Browsing in ACTIVE  

In the scope of the ACTIVE project we will adjust and reuse the existing semantically enabled social 

browsing service called LiveNetLife to create awareness between knowledge workers who are using similar 

context and/or are working on similar tasks in the same moment in time. That is, we will use the advanced 

mining functionalities of context task mining developed inside ACTIVE together with innovative GUI and 

service provision of LiveNetLife to present the user with information on who else is currently working on 

similar topic or trying to fulfil a similar task. 

LiveNetLife is a web service which enables web visitors to meet when using similar information. The service 

displays live people directly in the web page. One can see what other people are doing on other pages with 

interesting content. One can discover a crowd of people on popular web pages and communicate through 

voice, chat and mouse movement. The service is enabling people to become aware of each other across 

different yet similar web sites in real time. Figure 14 shows the service GUI interface.  

 

 

Figure 14: LiveNetLife GUI. The user can see other people who are at the same time using similar 

information. User can communicate via chat, audio or mouse movements. 

 

Figure 15 explains the existing LiveNetLife functionality. For instance, a couple is trying to rent a car. 

Therefore they visit the Google search engine to try to locate the best service provider. In the same time 

another person is just writing a web log on how to rent a car.  What is more the third person is a sales person 

at a particular rent a car agency who is trying to get new customers. Because all these people are in the same 

time using similar information it is beneficial for them to become aware of each other. This way the 

publisher of a web log will be able to share his experience with the couple. The sales person will be able to 

invite the couple to try renting with his or hers affiliated company.  

 

Figure 15: LiveNetLife service connects people who are in the same moment in time using similar 

information across different web pages and web sites. 
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In the scope of the ACTIVE project we will reuse the existing LiveNetLife functionality and enhance it with 

the task and context mining capabilities. This way we will create awareness between knowledge workers 

who are using similar context and/or are working on similar tasks in the same moment in time.  

For example, in Figure 16 we see how knowledge workers who are working in different applications inside a 

company can become aware of each other. A couple of new employees are checking the database of old 

projects and documents containing information about semantic analysis of client databases. An experienced 

employee is structuring his knowledge inside a WIKI about the past project named ACTIVE which was 

heavily involved in use of semantic technologies. What is more, the third employee is in the same moment 

preparing a bid to a potential client. The bid he is working on contains information about company 

experience on dealing with semantic technologies. Thus, everyone is working in the same context of 

semantic technologies. With LiveNetLife technology they will become aware of each other and become able 

to communicate via audio, chat and even mouse movement. This benefits them as the new employees can 

listen in on a conversation between the experienced employee and the person preparing the bid on how to 

make the bid even better.  

 

Figure 16: LiveNetLife service in ACTIVE will connect people who are working in similar contexts 

and on similar tasks. 

 

ACTIVE Knowledge Workspace will integrate LiveNetLife as additional functionality which will reuse the 

task and context mining results. Figure 17 shows how LiveNetLife service fits into the AKWS architecture 

from the top level view. The main idea is to use the existing LiveNetLife similarity search engine which is 

able to quickly find people who are online and are using similar context or task.  
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Figure 17: The top level architecture view of the AKWS system which includes the LiveNetLife service 

(top right) on top of the core AKWS functionality (in green and yellow color). 

 


